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                      General Description
The MAX9867 evaluation kit (EV kit) consists of a 
MAX9867 evaluation board and software. The EV kit is a 
fully assembled and tested circuit board that evaluates 
the MAX9867 low-power, stereo audio codec. The EV 
kit is designed to send and receive digital audio data in 
the Sony/Philips digital interface (S/PDIF) format and can 
be optionally configured to communicate using generic 
digital audio or I2S-compatible signals.

The EV kit provides two RCA jacks for analog audio input 
signals and two 3.5mm headphone jacks for analog 
audio output signals. The EV kit also provides fiber optic 
receiving and transmitting modules for digital audio input 
and output.

The EV kit includes WindowsM 2000-, Windows XPM-, 
and Windows VistaM-compatible software that provides a 
graphical user interface (GUI) for exercising the features 
of the MAX9867. The EV kit is connected to a PC through 
a USB A-to-mini-B cable.

                                       Features
S USB-PC Connection (Cable Included)

S USB Powered (External Power Supply Not 
Required)

S On-Board 12.288MHz and 13MHz Clock Oscillators

S On-Board Digital Audio Interface Transceiver

S On-Board Fiber Optic Transmitter and Receiver 
Modules

S Isolation Header for Direct Communication with 
the MAX9867 I2C and Digital Audio Interfaces

S Proven PCB Layout

S Windows 2000-, Windows XP-, and Windows Vista 
(32-Bit)-Compatible Software

                  Ordering Information

+Denotes lead(Pb)-free and RoHS compliant.

Windows, Windows XP, and Windows Vista are registered 
trademarks of Microsoft Corp.

                                                                                  System Diagram

EV KIT

S/PDIF DIGITAL
INPUTS AND OUTPUTS

ANALOG INPUTS

WINDOWS PC

 USB CABLE
SOFTWARE
REQUIRED

PART TYPE

MAX9867EVKIT+ EV Kit

For pricing, delivery, and ordering information, please contact Maxim Direct 
at 1-888-629-4642, or visit Maxim’s website at www.maximintegrated.com.
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                                                                                   Component List

DESIGNATION QTY DESCRIPTION

REQUIRED COMPONENTS

C1–C8, C10, 
C12, C13, 
C16, C17

13
1.0FF Q10%, 6.3V X5R 
ceramic capacitors (0402)
Murata GRM155R60J105K

C9 1
2.2FF Q20%, 6.3V X5R 
ceramic capacitor (0402)
Murata GRM155R60J225M

SUPPORT COMPONENTS

C11, C18 2
220FF Q20%, 4V tantalum 
capacitors (1206)
Nichicon F950G227MSAAQ2

C14, C15 2
1.0FF Q10%, 6.3V X5R 
ceramic capacitors (0402)
Murata GRM155R60J105K

C19, C20, C31–
C34, C37, C38

8
0.01FF Q10%, 16V X7R 
ceramic capacitors (0603)
Murata GRM188R71C103K

C21, C22, C27, 
C29, C35, C40, 
C42, C44–C47, 

C51

12
0.1FF Q10%, 16V X5R 
ceramic capacitors (0603)
Murata GRM188R61C104K

C23–C26, C43, 
C50, C53, C54

8
1FF Q10%, 10V X5R ceramic 
capacitors (0603)
Murata GRM188R61A105K

C28 1
0.047FF Q10%, 16V X7R 
ceramic capacitor (0603)
Murata GRM188R71C473K

C30 1
0.47FF Q10%, 16V X7R 
ceramic capacitor (0603)
Murata GRM188R71C474K

C36, C41 2
10pF Q5%, 50V C0G ceramic 
capacitors (0603)
Murata GRM1885C1H100J

C39 1
0.033FF Q10%, 16V X7R 
ceramic capacitor (0603)
Murata GRM188R71C333K

C48, C49 2
22pF Q5%, 50V C0G ceramic 
capacitors (0603)
Murata GRM1885C1H220J

C52 1
10FF Q10%, 6.3V X5R  
ceramic capacitor (0805)
Murata GRM219R60J106K

DESIGNATION QTY DESCRIPTION

C55, C56 2
0.1FF Q10%, 10V X5R  
ceramic capacitors (0402)
Murata GRM155R61A104K

C57–C61 0
Not installed, ceramic 
capacitors (0402)

D1 1
Surface-mount yellow LED 
(0603)

D2 1 Surface-mount red LED (0603)

FB1, FB2 2
0.1I DCR, 60I at 100MHz 
ferrite beads
Murata BLM18PG600SN1

J1 1
White phono jack (side entry, 
PCB mount)

J2 1
Red phono jack (side entry, 
PCB mount)

J3, J4 2
Surface-mount 3.5mm stereo 
headphone jacks

J5 1
Digital audio fiber optic  
transmitter module
Toshiba TOTX147L(F,T)

J6 1
Digital audio fiber optic 
receiver module
Toshiba TORX147L(F,T)

J7 1 Mini-B USB jack

JU1–JU11, 
JU14–JU18

16 2-pin headers

JU12 1 3-pin header

JU13 1 21-pin header (3 x 7)

L1 1
47FH Q5%, 200mA inductor 
(1812)
Coilcraft 1812LS-473XJLB

R1–R4 4 2.2kI Q5% resistors (0402)

R5, R6, R8 3 10kI Q5% resistors (0402)

R7, R11, R15, 
R16, R29

0 Not installed, resistors (0402)

R9, R10, R12, 
R13, R14

5 75I Q5% resistors (0402)

R17 1 402I Q5% resistor (0603)

R18 1 47kI Q5% resistor (0603)

R19, R20 2 220I Q5% resistors (0603)

R21, R22, R23 3 1.5kI Q5% resistors (0603)

R24, R25 2 27I Q5% resistors (0603)
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                                                                 Component List (continued)

*EP = Exposed pad.

Note: Indicate that you are using the MAX9867 when contacting these component suppliers.

                                                                           Component Suppliers

                                                                    MAX9867 EV Kit Files

DESIGNATION QTY DESCRIPTION

R26 1 470I Q5% resistor (0603)

R27 1 2.2kI Q5% resistor (0603)

R28 1 10kI Q5% resistor (0603)

R30 1 0I Q5% resistor (0402)

U1 1
Stereo audio codec (30 WLP)
Maxim MAX9867EWV+

U2, U3 2
Low-noise linear regulators 
(5 SC70)
Maxim MAX8510EXK18+

U4 1
Digital audio transceiver 
(28 SO)
Cirrus Logic CS8427-CSZ

U5, U6 2
2:1 high-speed muxes 
(6 SC70)

U7 1
USB-to-UART converter 
(32 TQFP)

U8 1
Microcontroller (56 TQFN-EP*)
Maxim MAXQ2000-RBX+

U9 1
Low-noise linear regulator 
(5 SC70)
Maxim MAX8511EXK33+

DESIGNATION QTY DESCRIPTION

U10 1
93C46 type 3-wire EEPROM 
(8 SO)

U11 1
Low-noise linear regulator 
(5 SC70)
Maxim MAX8511EXK25+

U12, U13 2
Digital microphones (6 LGA)
Akustika AKU2002C

Y1 1 12.288MHz clock oscillator

Y2 1
13MHz clock oscillator
Hong Kong X’tals 
C4M13000NSMI02601-0

Y3 1
16MHz surface-mount crystal 
oscillator

Y5 1
6MHz surface-mount crystal 
oscillator

— 1
USB high-speed A-to-mini-B 
cable, 6ft 

— 24 Shunts

— 1
PCB: MAX9867 EVALUATION 
KIT+

SUPPLIER PHONE WEBSITE

Coilcraft, Inc. 847-639-6400 www.coilcraft.com

Hong Kong X’tals Ltd. 852-35112388 www.hongkongcrystal.com

Murata Electronics North America, Inc. 770-436-1300 www.murata-northamerica.com

Toshiba America Electronic Components, Inc. 949-623-2900 www.toshiba.com/taec

FILE DESCRIPTION

INSTALL.EXE Installs the EV kit files on your computer

MAX9867.EXE Application program

FTDIBUS.INF USB device driver file

UNINST.EXE Uninstalls the EV kit software

USB_Driver_Help.PDF USB driver installation help file

http://www.hongkongcrystal.com/
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                                   Quick Start
Recommended Equipment

• MAX9867 EV kit (USB A-to-mini-B cable included)

• User-supplied Windows 7 or Windows 8 PC with a 
spare USB port

• Pair of headphones (16I or greater)

• Two single-ended analog audio sources

• Digital audio equipment with two TOSLINK optical 
cables

Refer to the MAX9867 IC data sheet while using this EV 
kit for detailed descriptions of the codec’s features.

Note: In the following sections, software-related items 
are identified by bolding. Text in bold refers to items 
directly from the EV kit software. Text in bold and under-
lined refers to items from the Windows operating system.

Procedure
The MAX9867 EV kit is fully assembled and tested. 
Follow the steps below to verify board operation before 
exercising the full features of the MAX9867:

1) Verify that all the jumpers are set in their default 
positions, as shown in Table 1.

2) Connect one TOSLINK optical cable between the 
digital audio equipment input and the J5 module on 
the EV kit board.

3) Connect the other TOSLINK optical cable between 
the digital audio equipment output and the J6 mod-
ule on the EV kit board.

4) Connect one analog audio source to the MICLP 
and MICLN pads on the EV kit board. Connect the 
MICLN pad to GND for single-ended microphone 
input.

5) Connect the other analog audio source to the MICRP 
and MICRN pads on the EV kit board. Connect the 
MICRN to GND for single-ended microphone input.

6) Connect one analog audio source to the J1 RCA 
jack on the EV kit board.

7) Connect the other analog audio source to the J2 
RCA jack on the EV kit board.

8) Connect the headphone to the J4 headphone jack 
on the EV kit board.

9) Set the digital audio equipment audio output and 
input sampling frequency to 48kHz.

10) Enable the digital audio equipment input and output.

11) Enable the analog audio sources.

12) Visit www.maximintegrated.com/evkitsoftware to 
download the latest version of the EV kit software, 
MAX9867EVSwSetupVx.x.ZIP.

13) Install the MAX9867 evaluation software on your com-
puter by running the MAX9867EVSwSetupVx.x.exe 
program. The program files are copied and icons 
are created in the Windows Start menu.

14) Connect the USB cable from the PC to the EV kit 
board. A New Hardware Found window pops up 
when installing the USB driver for the first time. 
If a window is not seen that is similar to the one 
described above after 30s, remove the USB cable 
from the board and reconnect it. Administrator privi-
leges are required to install the USB device driver 
on Windows.

15) Follow the directions of the Found New Hardware 
window to install the USB device driver. Manually 
specify the location of the device driver to be  
C:\Program Files\Maxim Integrated\MAX9867 
(default installation directory) using the Browse but-
ton. During device driver installation, Windows may 
show a warning message indicating that the device 
driver Maxim uses does not contain a digital signa-
ture. This is not an error condition and it is safe to 
proceed with installation. Refer to the USB_Driver_
Help.PDF document included with the software for 
additional information.

16) Start the MAX9867 EV kit software by opening its 
icon in the Start | Programs | Maxim Integrated | 
MAX9867 menu.

17) The EV kit software main window appears, as shown 
in Figure 1. Verify that the message MAX9867: 
Connected is displayed on the status bar at the bot-
tom of the software’s main window.

18) In the Clock Configuration group box, press the 
Configure button.

19) In the MCLK Sources group box, click on the 
Recovered Master Clock radio button.

20) Click on the DAC and Headphone Outputs tab. 
In the Headphone Output Mode drop-down list, 
select Stereo OCL.

21) Click on the Mic and Line Inputs tab. In the Line 
Inputs group box, check the Enable Left Line In, 
Enable Right Line In, Mute Left Line In, and Mute 
Right Line In checkboxes. Muting the input does 
not prevent the input from routing to the ADCs.

22) Click on the Filters tab. In the Codec Filtering 
Mode drop-down list, select Audio (FIR).

www.maximintegrated.com/evkitsoftware
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23) On the top-right corner of the software’s main win-
dow, select Enabled from the drop-down list.

24) Verify that audio from the digital audio equipment 
is output at the headphone and the analog audio 
sources are output to the digital audio equipment.

   Detailed Description of Software
Software Main Window

On the top of the main window, press the Read All but-
ton to read all the MAX9867 register values and update 
the GUI. Press Reset to reset the EV kit hardware. Press 
Connected to set up the connection between the EV kit 

and the software application. The drop-down list allows 
a user to enable or disable the MAX9867.

The Device Status group box reports the status of vari-
ous device functions. Check/uncheck the checkboxes to 
enable/disable the hardware interrupts for each status 
flag.

The lower side of the main window includes eight tabs. 
On each tab sheet, the user can exercise a group of 
related configurations and check the register values. 
Each control on the GUI generates the expected read 
and/or write operations on the internal registers of the 
MAX9867 and the CS8427 digital audio transceiver.

Figure 1. MAX9867 Evaluation Software (Main Window)
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File Menu
Select the Save Configuration menu item to save the 
current EV kit configuration to a text file that can be 
loaded at a later time. Select Load Configuration to 
reload settings from a saved file.

Select Exit to exit the application.

View Menu
Select the Show Test Mode Registers menu item to 
display or hide the MAX9867 trim registers and test reg-
isters tab sheets.

Select Show CS8427 Registers to display or hide the 
CS8427 tab to change the digital audio transceiver reg-
isters.

Options Menu
Select the Power On Reset menu item to reset the 
MAX9867 to its power-on state. Select Read Status to 
read the MAX9867 status registers. Select Auto Read 
Status to enable the automatic read of the MAX9867 sta-
tus registers. Select Auto Connect to automatically set 
up the connection between the EV kit and the software 
application in case the connection is lost.

Tools Menu
Select the Reconnect to EVKIT menu item to set up the 
connection between the EV kit and the software applica-
tion.

Select Debug Mode to bring up the Advanced User 
Interface window. The interface allows I2C operations, 
such as read byte and write byte, to be executed. The 
I2C dialog boxes accept numeric data in binary, deci-
mal, or hexadecimal. Hexadecimal numbers should be 
prefixed by $ or 0x. Binary numbers must be exactly 
eight digits. See Figure 2 for an example of this control 
method.

Help Menu
Select the Help menu item for information about the 
software.

Clock and Digital Audio Tab
The Clock and Digital Audio tab sheet (Figure 1) 
contains the master clock (MCLK) and digital audio 
interface selections for the MAX9867. A user can select 
an automatic typical interface configuration or manually 
configure the device according to specific requirements.

DAC and Headphone Outputs Tab
The DAC and Headphone Outputs tab sheet (Figure 3) 
includes the DAC enable and gain controls. It also includes 
the headphone output mute, level, and mode controls.

AUX and Jacksense Tab
The AUX and Jacksense tab sheet (Figure 4) includes 
the measurement control of an AUX input. It also includes 
the jack detection controls. Do not use the DC-voltage 
measurement and jack detection at the same time.

Mic and Line Inputs Tab
The Mic and Line Inputs tab sheet (Figure 5) includes 
the microphone and the line input controls.

ADC and Sidetone Tab
The ADC and Sidetone tab sheet (Figure 6) includes 
the controls for the ADC and the sidetone circuitry on 
the MAX9867.

Filters Tab
The Filters tab sheet (Figure 7) controls the functionality 
of the DAC and ADC filters on the MAX9867.

Registers 1 and Registers 2 Tabs
The Registers 1 tab sheet (Figure 8) and the Registers 2 
tab sheet (Figure 9) list all of the MAX9867 registers. To 
change a register value, type in the new value in the appro-
priate edit box and press the Enter key on the keyboard, or 
click the bit names on the GUI.

CS8427 Tab
The CS8427 tab sheet (Figure 10) displays the EV kit-
related CS8427 register values on one page. To change 
a register value, type in the new value in the appropriate 
edit box and press the Enter key on the keyboard, or 
click the bit names on the GUI.
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Figure 2. MAX9867 Evaluation Software (Advanced User Interface)
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Figure 3. MAX9867 Evaluation Software (DAC and Headphone Outputs Tab)
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Figure 4. MAX9867 Evaluation Software (AUX and Jacksense Tab)
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Figure 5. MAX9867 Evaluation Software (Mic and Line Inputs Tab)
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Figure 6. MAX9867 Evaluation Software (ADC and Sidetone Tab)
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Figure 7. MAX9867 Evaluation Software (Filters Tab)
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Figure 8. MAX9867 Evaluation Software (Registers 1 Tab)
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Figure 9. MAX9867 Evaluation Software (Registers 2 Tab)
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Figure 10. MAX9867 Evaluation Software (CS8427 Tab)
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  Detailed Description of Hardware
The MAX9867 EV kit is a complete digital audio evalu-
ation system for the MAX9867 low-power, stereo audio 
codec. The EV kit provides translation between the 
digital audio signals and optical S/PDIF signals to allow 
easy connection with consumer electronics devices. See 
Table 1 for a description of all EV kit jumper configura-
tions.

Clocking
On-Board Clock

The EV kit has one 12.288MHz and one 13MHz clock 
oscillator on the board to provide flexible master-clock 
selections for the MAX9867.

Recovered Clock
When the S/PDIF IN has a digital audio input and the 
S/PDIF transceiver is in operation, the recovered clock 
from the S/PDIF transceiver can be used as the master 
clock for the MAX9867.

External Clocks
Connect an external clock source to jumper JU12 pin 2 
to drive the MAX9867 MCLK pin without using the on-
board oscillator. The user must type in the correct clock 
frequency in the MCLK Frequency edit box.

Jack Detection and  
DC-Voltage Measurement

The MAX9867 has a JACKSNS/AUX pin that can be con-
figured to either detect the presence/absence of a jack 
or accurately measure a DC voltage.

To measure a DC voltage, place a shunt on jumper JU7 
and apply the DC voltage on the AUX pad. The on-board 
resistor network (R5, R6) can be used to adjust the input 
voltage ranges.

To detect the presence or absence of a jack, remove the 
shunt on jumper JU7 and connect the JACKSNS pad to 
a proper jack pin. Refer to the MAX9867 IC data sheet 
for the details of jack-detection functionality.

Microphone Inputs
The MAX9867 features stereo differential microphone 
inputs that can be connected to either analog or digital 
microphones.

MICRP and MICRN pins can only connect to an analog 
microphone. Place shunts on jumpers JU1 and JU3 to 
use the MAX9867 MICBIAS for microphone biasing. 
Place a shunt on jumper JU2 to connect MICRN to GND 
for single-ended microphone input.

MICLP/DIGMICDATA and MICLN/DIGMICCLK pins can 
connect either to an analog microphone or a digital 
microphone, but not at the same time. For analog 
microphone input, remove the shunts on jumpers JU8 
and JU9. Place shunts on jumpers JU4 and JU6 to use 
the MAX9867 MICBIAS for microphone biasing. Place 
a shunt on jumper JU2 to connect MICLN to GND for 
single-ended microphone input. For digital microphone 
input, place shunts on JU8 and JU9 and remove con-
nections on the MICLP and MICLN pads. There are two 
digital microphones on the EV kit board.

Headphone Outputs
There are two headphone jacks on the EV kit board.

Use J4 for differential or capacitorless output configura-
tion. Remove the shunts on jumpers JU10 and JU11.

Use J5 for single-ended output configuration. Remove 
the shunts on jumpers JU10 and JU11 for fast turn-on 
mode. Place the shunts on JU10 and JU11 for clickless 
mode.
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Table 1. Jumper Descriptions (JU1–JU18)

*Default position.

JUMPER SHUNT POSITON DESCRIPTION

JU1
Open* MICRN disconnected from GND

1-2 MICRN connected to GND through a 2.2kI resistor

JU2
Open* MICRN disconnected from GND

1 - 2 MICRN connected to GND

JU3
Open* MICRP disconnected from MICBIAS

1-2 MICRP connected to MICBIAS through a 2.2kI resistor

JU4
Open* MICLP disconnected from MICBIAS

1-2 MICLP connected to MICBIAS through a 2.2kI resistor

JU5
Open* MICLN disconnected from GND

1 - 2 MICLN connected to GND

JU6
Open* MICLN disconnected from GND

1-2 MICLN connected to GND through a 2.2kI resistor

JU7
Open* JACKSNS/AUX used for jack detection

1-2 JACKSNS/AUX used for AUX DC measurement

JU8, JU9
Open* MICLP/MICLN disconnected from digital microphone

1-2 MICLP/MICLN connected to digital microphone

JU10
Open* ROUTN connected to GND through a 1FF capacitor

1-2 ROUTN disconnected from GND

JU11
Open* LOUTN connected to GND through a 1FF capacitor

1-2 LOUTN disconnected from GND

JU12, JU13
2-3* (all rows) MAX9867 connected to on-board I2S and I2C interfaces

Open MAX9867 I2S and I2C interfaces available for user-supplied equipment

JU14
1-2* MAX9867 DVDD connected to on-board 1.8V supply 

Open MAX9867 DVDD applied externally on DVDD pad

JU15
1-2* MAX9867 AVDD connected to on-board 1.8V supply 

Open MAX9867 AVDD applied externally on AVDD pad

JU16
1-2* MAX9867 PDD connected to on-board 1.8V supply 

Open MAX9867 PVDD applied externally on PVDD pad

JU17
1-2* MAX9867 DVDDIO connected to on-board 3.3V supply 

Open MAX9867 DVDDIO applied externally on DVDDIO pad

JU18
1-2* CS8427 powered by 5V USB supply 

Open CS8427 powered by external supply on CS8427_5V pad
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Figure 11a. MAX9867 EV Kit Schematic (Sheet 1 of 4)
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Figure 11b. MAX9867 EV Kit Schematic (Sheet 2 of 4)
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Figure 11c. MAX9867 EV Kit Schematic (Sheet 3 of 4)
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Figure 11d. MAX9867 EV Kit Schematic (Sheet 4 of 4)
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Figure 12. MAX9867 EV Kit Component Placement Guide—
Component Side

Figure 14. MAX9867 EV Kit PCB Layout—Inner Layer 2

Figure 13. MAX9867 EV Kit PCB Layout—Component Side Figure 15. MAX9867 EV Kit PCB Layout—Inner Layer 3
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Figure 16. MAX9867 EV Kit PCB Layout—Inner Layer 4 Figure 17. MAX9867 EV Kit PCB Layout—Inner Layer 5

Figure 18. MAX9867 EV Kit PCB Layout—Solder Side
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